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1 Background

Dune Lake Galaxiids (Galaxias sp.) are a freshwater fish with a highly restricted distribution being
largely confined to dune lake habitats in the Northland region of New Zealand. These dune lake
populations have been recognised as an evolutionarily significant unit of the Galaxias maculatus
species complex, and work is currently underway to investigate if they are a separate species.
According to the Department of Conservations freshwater fish threat ranking system, Dune Lake
Galaxiids (DLGs) have a threat status of “At-risk” and there are growing concerns about the
conservation and management of DLGs in Northland (Dunn et al 2018).

An Envirolink advice report commissioned in 2017 examined the effects of continued trout stocking
in Lakes Waikare and Taharoa on DLG populations and an extensive monitoring design for DLG
populations was proposed (Gee and Franklin 2017). Key information gaps regarding DLG biology and
ecology were identified in particular the extent of DLG reproduction timing (Pingram, 2005) and the
location of DLG spawning habitats. The DLG Science Working Party was formed to make the
monitoring advice provided by Gee and Franklin (2017) operational. The DLG science strategy is
implemented by a joint working group called “The Kai Iwi Lakes Dune Lake Galaxias Working Group”.
This working group consists of representatives from Northland Regional Council, the Department of
Conservation, Kaipara District Council, Te Roroa/Te Kuihi iwi, Northland Fish and Game Council and
NorthTec. This working group has identified seven research priorities for DLG management and
conservation in Northland. One of these priorities is to gain a better understanding of the spawning
ecology of DLGs with the overarching goal of gaining a better understanding of pressures from
predators such as rainbow trout (Oncorhynchus mykiss) and gambusia (Gambusia affinis) in the Kai
Iwi Lakes. The spawning habitats of DLGs are presently unknown but it is hoped that an analysis of
the larval hatching dates of DLGs from otoliths will narrow the reproductive timing of DLGs and
based on the results, targeted searches for eggs and spawning habitat can be done in the future.

To support the working groups research priority, an Envirolink Medium Advice Grant was applied for
to provide training for the aging of DLGs using otoliths (calcium carbonate structures akin to ear
bones) and to back-calculate DLG larval hatching dates from daily growth rings. The skills acquired by
Northland Regional Council will be used in future monitoring and research programmes on DLG
populations. Developing capacity and capability among stakeholders in the Northland Region is key
to future work on DLG populations. This training can be shared further with other parties managing
freshwater native fish recovery, especially the galaxiids.

A workshop was hosted at NorthTec in Whangarei (16th — 20th November 2018) and was attended
by Northland Regional Council and NorthTec staff and students. Otolith training was provided by Dr
Eimear Egan (NIWA Hamilton). This document summarises the methodology and key steps in the
preparation of DLG otoliths for ageing and larval hatch date estimation.




@/’ Taihoro Nukurangi
1.1 What are otoliths

Otoliths are calcium carbonate structures that are used by fish to maintain balance and are used for
hearing. Otoliths are regarded as one of the most informative tools for understanding the biology
and ecology of fish because a vast amount of information about an individual is recorded in the
otolith via daily ring deposition (Campana and Neilson, 1985). Daily ring counts can be used to
estimate age at time of capture and hatching dates of DLG larvae (date at capture — age = larval

hatch date). Although the exact date of spawning is difficult to determine, an assumed egg
development duration of 3-4 weeks means that spawning dates can be estimated (larval hatch date —
21/28 days = spawning date). Furthermore, dark features/check marks and abrupt changes in the
otolith coincide with important life history events such as larval hatching, metamorphosis and sexual
maturity and can be used to identify the timing of these critical events (Campana and Neilson, 1985).

Otolith size and fish size are often proportional meaning that the distance between daily rings can be
used to examine growth rates (Campana and Neilson, 1985). From the daily increment pattern, a
time series of an individual’s growth history can be derived, providing insights into how DLGs grow
from the larval through to juvenile and adult stages. The growth of DLG can be compared among fish
hatched at different times of the year. This would give an indication of how growth and potentially
survival varies between larval hatch dates and associated seasonal changes in environmental
conditions (Egan et al. 2019).

2 Methodology

2.1 Otolith extraction, preparation, polishing and increment counts

A random subset of DLGs were used in the otolith workshop including fish that were preserved in
ethanol, fish that were frozen immediately following sampling and DLGs that were extracted from
the stomachs of trout. The deposition of daily rings on the otoliths has not been validated for DLGs,
however daily ring deposition has been validated for a closely related species Tnanga (Galaxias
maculatus; McDowall 1994) and was assumed here for DLGs. A checklist of equipment needed for
otolith extraction and preparation is given in Appendix A.

The sagittal otoliths lie inside the otic capsule located toward the posterior end of the ventral surface
of the skull (Figure 2-1). DLG sagittal otoliths were extracted under a dissecting microscope by
making an incision in the head with a scalpel and peeling apart the tissue so that the otic capsule
could be identified. Fine-tipped forceps were then used to extract both the left and right sagittal
otoliths which were cleaned from adhering tissue using a fine paint brush and deionised water
(Figure 2-2). The otoliths were stored in 96 well trays to dry for 24 hours before polishing.
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Figure 2-1:  Diagram showing location of otoliths from Campana (2004).
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Figure 2-2:  Adult Dune Lake Galaxiid and extracted sagittal otolith with sulcus side facing up.

The sagittal otoliths were mounted sulcus side up onto glass microscope slides using CrystalBond™
509 adhesive. Sagittae were polished longitudinally using South Bay Technology aluminium oxide
12um and 0.3um lapping film? (Figure 2-3). Polishing was done using the “wet” method where a few
drops of water were added to the polishing film to increase contact with the otolith. Firm but even
pressure was place on the microscope slide and otoliths were polished in a clockwise direction.
Where necessary, sagittae were remounted and polished sulcal side down until a complete daily
increment sequence from core to post-rostral edge was visible. Remounting was done by placing the
microscope slide on a hot plate at approximately 180°C until the CrystalBond™ was melted
sufficiently to allow the otolith to be reoriented. This process was done multiple times because of the
thickness of the otoliths especially for larger DLGs.

The otolith polishing process was inspected continually to ensure over polishing does not occur
(Figure 2-4). Examples of otoliths that were discarded from subsequent analysis are shown in Figure
2-5. These include otoliths that cracked during polishing from excess pressure, otoliths that were not
cleaned of adhering tissue which resulted in black “spots” and an over polished otolith showing
poorly resolved rings at the otolith edge (Figure 2-5). Polished DLG sagittae were wiped with tissue
and then soaked in a drop of immersion oil. A coverslip was placed over the otolith and sealed with
clear nail varnish. A unique identifier for each otolith was inscribed on the glass slides using a

1 http://www.southbaytech.com/consum.shtml
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diamond pen. The otoliths were then soaked overnight to increase clarity before photomicrographs
were captured using 10x, 20x and 40x objective lenses.

Figure 2-3: 30, 12, 5 and 0.3 um film that can be used to polish Dune Lake Galaxiid otoliths.
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Figure 2-4:  Otoliths are continually checked during the polishing process to ensure an even polishing axis is
obtained and that over polishing does not occur.
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Figure 2-5: Examples of poor Dune Lake Galaxiid otolith preparation including cracked otoliths, burned
organic matter which appears as dark splotches because of poor cleaning and over polishing giving a rainbow
effect.

Examples of good otolith preparations are shown in Figure 2-6. A clear sequence of daily increments
from the otolith core to edge was obtained. Furthermore, the larval hatching mark is clearly defined,
and the daily increments are clear. Increment deposition from the hatch mark was naturally directed
towards the post-rostral axis and the presence of confounding checkmarks and convergent/divergent
rings were generally less apparent here (Figure 2-6). The relationship between fish size (total length
(mm)) and otolith size (width (mm)) can be derived using linear regression (Figure 2-7) to meet the
assumption that otolith growth is linear and proportional to somatic growth if growth
reconstructions are required (Campana and Neilson 1985). Prepared otoliths should be stored in a
slide tray or slide box which is clearly labelled.




Figure 2-6: Examples of good otolith preparation showing a clear transect from otolith core to post-rostral edge (red arrow), a clearly demarcated hatch mark at the center
of the otolith (red arrow) and clear daily increment sequences. Taken from Egan et al. 2019.
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Figure 2-7: Relationship between otolith width (mm) and fish length (mm) for a closely related species
nanga (Galaxias maculatus). Taken from Egan et al. 2019.

Image J? is a freely downloadable software with a plugin called Object J? that can be used for
counting otolith increments and to measure the distance between increments. Excellent tutorials
exist for the analysis of otoliths using Object J (see
https://sils.fnwi.uva.nl/bcb/objectj/examples/otoliths/MD/otoliths.html). The Object J manual for
counting and measuring otolith growth rings is given in Appendix B. The hatch-mark is well defined in
DLG otoliths and was clearly identified in all otoliths examined in the workshop (see example in
Figure 2-6). Increment counts should be made from the hatch mark to the otolith edge and the data
for each individual fish stored in an excel sheet.

2 https://imagej.nih.gov/ij/download.html
3 https://sils.fnwi.uva.nl/bcb/objectj/examples/otoliths/MD/Tutorial Otoliths Object).pdf
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https://sils.fnwi.uva.nl/bcb/objectj/examples/otoliths/MD/Tutorial_Otoliths_ObjectJ.pdf
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Appendix A Equipment needed for otolith preparation

e Compound microscope

e Dissecting microscope

e Camera to take photomicrographs
e  5x, 10x, 20x, 40x objective lenses
e Microscope slides

e Cover slips

e Nail varnish

e Immersion ail

e Hotplate

e (CrystalBond™

e Fine forceps (several)

o Small scalpel and spare blades

e Polishing film (12,9, 5, 0.3 um)

e 96 well extraction plates for otolith storage
e Diamond pen

e Slide holders/slide box

e Fine tipped permanent marker

e Paintbrush

e Petridish

e Software for doing otolith increment measurements (Image J and Object J plugin)




Appendix B Object J manual

ObjectJ: Measuring Growth Rings in Fish
Otoliths

Céme Denechaud >°, Anders Thorsen 2, Norbert Vischer '

! University of Amsterdam (UvA}, Amsterdam (Netheriands)
2 Institute of Marine Research (Hl), Bergen (Norway)
3 University of Bergen (UiB), Bergen (Norway)

Description

This tutorial is destined to help using Imaged with plugin Objectd for "Measuring growth
ingrements in fish otoliths”. Ageing and growth of fish based on otoliths has been adapted
from the study of tree rings and is now widely used and developed In fisheries science. By
measuring otolith increments, one can estimate past growth and correlate it with different
environmental or population variables.

This plugin is designed to measure these increments in a standardized and straightforward
way, as well as to provide a comprehensive output directly transferable for further use. Note
that while it is flexible, the plugin was primarily developed to measure growth patterns along
the distal axis. Consequently, it might require a few changes to be adapted for ventral or
dorsal axis measurements, since standard methodolegies often require break points and
multiple lines from the core to the edge of the otolith.

Setting up a project
+ Loading data in ObjectJ

To start a new project, download the project file (currently "Otoliths_1.8.0jj") pravided on the
website and move it into the directory that cantains your otolith images. The ".¢jj* project file
contains the proper setup for measuring increments, as well as the necessary embedded
macros. The first step is 1o link the images to the project, either one by one or by directly
linking all images from a folder.

Just choose Object)>Show Project Window > Linked Images > choose images one by one
or choose a location folder to link all images from. Images can also be dragged directly from
Finder/Explorer onto the "linked images™ logo.

Objectd stores the overlay consisting of colored markings in the project file. Neither the
images nor their own overlays are not modified. Additionally, all the measurements will be
saved inside the project file without creating additianal files.

+ Scaling pictures (pixels/unit)

All linked images should now appeat in the project window. If the pictures aren't scaled or if
they are in a format that doesn't contain metadata {such as .JPG), they can easily be scaled
in Objectd. In the project window, right click on the “px/unit” column and enter a scale and a
unit. If multiple pictures were taken in a batch, the scale can be propagated to all of them by
clicking the correspending checkbox,
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If the scale is nat known, it can be measured using a calibration picture. In base Imaged,
measure the scale with the line tool and extract the corresponding value. It can then be used
as a scale for the images, granted they were taken under the same conditions than the
calibration picture. It is possible to scale the linked images afterwards, which will recalculate
the results.

* Project window

With a guick look at the rest of the project window, two more tabs can be noticed: “Objects”
and "Columns’.

“Objects” shows the "items" that will be created during the measuring process, The
sequence is made of two lines called “core” and “vector” and finishes with a series of
points called “increments”. The column “clones” indicates the number of items from
one type: in this project, there will always be only one core ling, one vector ling, and
up to 99 increment points, One can easily change these values but it is
recommended to leave them as it is, since the number of increments can easily
range from a few to several dozen. These items are essential 1o the measuring
process and their names are tied to the macros coding: it is thus also recommended
to leave them, as any change will require to manually edit the macros
correspondingly. The item colors (currently green core, red wvector and blue
ingrement} can be changed without problem.

- “Columns” shows various values that will be displayed with "Object) results”.
However, the ring measurements won’t be displayed here but in. a macro output.
Because these columns names are also tied to the functioning of the macyos, it is
recommended to leave them untouched.

Measuring sequence
+ Annotating images

Once the images are linked to the project and scaled, the measuring sequence can start.
Just open any image with a Double Click. The sequence can be started by clicking in
Objectd > Start a sequence, or by simply pressing F1, which is the designed shartcut of this
first macro.

This starts the sequence with the first item, a segment called “Care”. Simply place the two
extremities on the core edges so that it crosses the theoretical center. Determining with
precision the core origin can be difficult and highly subjective, and therefore the first
increment is often removed from chronologies. Drawing this arbitrary line will give a
standardized distance that can then be used as an additional proxy for comparing first years
of growth,

The sequence then automatically switches to a second item, ancther segment called
“Vector", This segment is central for further processing, It will act as both an axis and a
measuring tool. Simply place two points, one at the theoretical core center and one at the
_otalith edge, to draw the corresponding axis.

It will then move on to the final item, a series of points called “lncrement”. Just place each
point on its correspending growth ring to mark it, and progressively move from one extremity
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to the other. If a point is misplaced, simply delete it by pressing Backspace. This will remove
points by chronological order, starting from the most recent.

To delete specific items, go in the OhiectJ Tools window and select the Pistol tool. Kesp Alt
key down and click on one point to delete it, or keep Shift down and click on a point to delete
the entire associated item. Then, to resume annotating, select the Finger tool and double
click on any point, which "opens" the selected object so it can receive more markings. The
sequence will resume at the selected item type. To delete an entire object (i.e all three
items), simply use the Pistol 1ool without pressing any action key.

While it is important to be precise when annotating growth increments, keep in mind that this
macro also has a builtin function to pin dots on the measuring axis (see below).
Consequently, it is not problematic if the points aren’t exactly aligned, as long as the
deviation isn't significant. Similarly, the points can be clicked in any order without affecting
the results.

= Inputs for known year and quality

Once every item has been placed, the sequence can be ended by clicking on ObjectJ > Year
and quality, or by pressing the F2 shortcut. This macro opens a dialog box with two fields,

- First, it requires a known year. A positive value assigns subsequent years from the
core to the last increment, thus corresponding to a known cohort. A negative value
can instead be used if only the fishing date of the individual is known. The given year
will here be attributed to the outermost increment and the ageing will go backwards
down from the edge to the core center. Use the macrc F4 to toggle on and off these
values for reading purposes.

- Then, it asks for a quality value. This is an arbitrary scale of the sample quality,
defined directly by the user. A basic scale goes as foliows. If the increments are
clear, well conirasted and easy to read, mark the samples with quality "1" (Very
Good). If the sample is readable as a whole but small issues hinder the measuring
process, a quality “2" {Good) can be chosen. On the other hand, if the sample is
degraded or broken, if the picture is of poar quality, or if the increments are split and
significantly harder to read, assign a quality 3 (Poor). This stamp makes it easy to
manipulate the measurement data, for example to subset difficult oteliths from the
dataset to remove uncertainties.

As mentioned before, this macro also pins {projects) the increment (blue dois} onlo the
"Vector” line, This way the displacement will be minimal and the results won't be impacted,
as long as the points were placed close to the axis.

After an otolith is finished via "Enter year and quality”, simply move on to the next image and
repeat the seguence to annotate it.

Getting the output results

Once every sample in the project has been annotaied, the output results can be generated
by clicking on Object) > Create cutput table, or once more by simply pressing the shorfcut
F3. This macro does several things:
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1) It arranges vector direction and ring sequance to facilitate increments measurement.
First, distances between increments will always be calculated as an ascending path
from the inner to outer end of the Vector, no matter which way the axis was drawn.
Second, if the increments weren’t put in order or if some were noticed and added
[ater, it will correct their sequence so that they always rank from the core to the edge.

2) It measures the distance between each increment along the Vector. The first
measurement is the disiance from the Vector start tc the first Increment point. The
following cnes will be between consecutive increments. The final measurement will
be the remaining distance between the last increment and the edge of the otolith
{end of the Vector). This measure will correspond to the most recent growth over a
period inferior to a year.

3) Finally, it groups the results in an output table organized in several columns:
a. Sample: name of the image, minus the file extension
b. Quality: quality stamp assigned with the second macro
c. Age: age of the fish calculated with the number of increments measured
d. Cohort: cohert of the fish (birth year), calculated from the known year and the
number of increments
Core: arbitrary core diameter
f. |: sequence of the incremenis. Will always start with “core” and end with "edge”,
with any number of increments in between,
9. Year: year assigned to each increment based on the year provided in macro
"Year and Quality..."
h. Increment: measured width of each increment

o

This table displays each sample one under another in alphabetical order, and each

ﬁ Otolith Parameaters.od

File Edit Font
sample  [Quality |age [Cohort [Core | [Year [increment
N-2005 43 1 g 1997  1827.8 core
- K-2005 48 1 g 1997 19278 A1 1098 4061
M-2005 49 1 & 1997 19278 2 1989 2504
Sample 49, M-2005 49 1 g 1997 19278 3 2000 287.2
with each N-2005_49 1 g 1997 18278 4 2000 2328
increment M-2005_49 1 g 1997 192785 5 2002 1884
on an N-2005 48 1 g 1997 19278 & 2003 14948
individual M-2005 49 1 8 1997 182748 7 2004 1385
row M-2005 49 1 8 1997 19278 8 2005 1392
MN-2005 49 1 g 1997 1927.8 edge 436
M-2005 80 1 8 1997 1902.1 core
M-2005 50 1 g 1937 18021 1 1928 3146
M-2005 50 1 8 1997 19021 2 1999 2790
M-2005 80 1 g 1997 18021 3 2000 276.5
M-2005 50 1 8 1997 12021 4 2001 228 2
M-2005_50 1 8 1997 19021 & 2002 1718
N-2005_ 50 1 8 1997 1902t 6 2003 1881
M-2005_50 1 a2 1997 19021 7 2004 1636
M-2005 50 1 5 1997 19021 8 2005 1422




measuremeant as an individual row. See figure below for illustration.

Because this table will display any number of measurements from all the images linked to
the project file, is it recommended to first annotate every sample and then print out the
results as a single, comprehensive table. Nonetheless, the table can be re-generated every
time a new image has been annotated or comected: the output table will always display the
samples in alphabetical order, and any image left unannotated simply won't appear in the
measuring table.

Another great functionality of this plugin is its ability to produce measurements that are easy
to export and use. With "Otolith Parameters.txt” in front, simply save the table as a .csv
document that can be efforflessly imported in Excel/R/Matlab or examined in a standard
growth chronology model.

Final words

This Object) project works as a simple and intuitive extension to annotate and measure
growth from fish otoliths in a non-destructive way. Its ability to annotate increments in a few
clicks and to deliver result tables that are both comprehensive and simple to export makes it
a useful tool for any level, without requiring any advanced knowledge of image editing
software. Object)'s overlay also allows to annotate and later review JPG images without
having to store them as TIF. Besides, it can be used on a wide range of fish species, and
can even be adapted to measure daily growth in juveniles’ hard structures with some slight
changes to the embedded macros.
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